ELMHURST COLLEGE

GEQ 101-52 (Online)

GEO 101-52 Introduction to Meteorology (Online)

GEO 101-52 Introduction to Meteorology (Online) — (1.0: 1IST)

Fall 2009
One-time Face-to-face meeting: Monday, Aug. 31: 6:00 PM SC 003
Professors: Dr. Rich Schultz Teaching Asst.: Mr. Brian Firek
Asst. Professor, Geography firekb@net.elmhurst.edu
Office: Daniels Hall 316
Voicemail:  (630) 617-3128
E-mail: richs@elmhurst.edu

Office Hours: M 9:00-10:30 AM;
T 9:30-10:30 AM;
W 9:00-10:30 AM
or by Appointment

INSTRUCTIONAL MATERIALS & RESOURCES:

Required Texts

Online Weather Studies (Textbook) and Investigations Manual 2009-
2010/Summer 2009 (Lab Manual): ISBN 13: 97818782200936 (packaged as a
“‘bundle”) Copyright 2009 American Meteorological Society.

In addition, you will be required to pay a required materials/technology fee (as
per the College Catalog) on the first day of class to your instructor. The materials
and technology fee is $25.00. You may pay in cash or bring a check made out to
“‘Elmhurst College” on the evening of the mandatory meeting at which time you
will receive your course CD.

COURSE DESCRIPTION: Study of the major characteristics, patterns, and
processes of dynamic change that distinguish the Earth’s weather and climate



and its related influence on the biosphere. Topics addressed include: solar and
Earth radiation, air temperature, air pressure and winds, precipitation, air masses
and fronts, circulation patterns, severe weather occurrences, storms, and
climate. The impact of human technology on weather and climate and the
biosphere is discussed from the major social, ethical, and cultural perspectives.
Two additional important objectives of this course are to fulfill the college's
general education requirements for the Inquiry and Issues in Science and
Technology category and to familiarize students with the discipline of

geography.

Overarching Goals as a Gateway to Liberal Learning:
1. Instill a sense of lifelong learning
2. Promote effective communication skills
3. Learn to celebrate diversity in all of its forms
4. Appreciate the practical aspects of science affecting one’s life in society

COURSE LEARNING OBJECTIVES:
After successfully completing this course, a student should be able to:

a. Develop a fundamental understanding of the processes responsible for
weather and climate, materials that form Earth's atmosphere, and the
distribution on Earth of these processes, elements, and occurrences.

b. Have a general understanding of the climatic regions of the U.S.

Develop applied lab skills using various meteorological maps

Have a basic understanding of environmental and climate-related issues as to

how they relate to affecting culture of various peoples

e. Have a sound comprehension of the various dimensions of human-
environmental interactions, including cultural and socio-political implications

f. Understand and develop an appreciation for the occupation of meteorological
study

g. Improve their information literacy and digital citizenship.

oo

This course fulfills the students' requirement within the Inquiry and Issues in
Science and Technology (IST) General Education category. In addition to
these learning objectives for this course, the learning objectives for general
education curriculum courses also apply. These include the following:

1. Develop critical thinking and problem solving skills through
active exploration of natural science concepts and methods
within a scientific discipline;

2. Identify and consider social, philosophical, and ethical
guestions associated with science and technology topics; and

3. Recognize the strength and power of scientific and
technological knowledge as well as its limitations.

ACADEMIC INTEGRITY: The very nature of higher education requires that
students adhere to accepted standards of academic integrity. Therefore,



Elmhurst College has adopted a Code of Academic Conduct and a Statement of
Student Academic Integrity. These may be found in the current College Catalog
and E-Book. Among the violations of academic integrity listed and defined are:
cheating, plagiarism, falsification and fabrication, abuse of academic materials,
complicity in academic dishonesty, falsification of records and official documents,
personal misrepresentation and proxy, and bribes, favors, and threats. It is the
student's responsibility to be aware of behaviors that constitute academic
dishonesty.

METHOD OF INSTRUCTION: Audio-visual materials such as PowerPoint™
presentations, animations, Internet resources, and/or online readings will
augment weekly online text-based lectures. Interactive laboratory exercises will
emphasize practical hands-on experience and learning proper techniques for
identifying weather occurrences, interpreting weather maps, storms, and other
climatic data. Internet exercises will provide additional hands-on experience. All
work will be accomplished and submitted online. This is a “paperless” course.

COURSE PRACTICES REQUIRED:

1. Itis crucial that students read all assigned material and/or
handouts when the week’s learning module is posted.

2. A late penalty will be assessed for homework turned in past the
due date. ANY HOMEWORK MORE THAN ONE (1) WEEK LATE
WILL NOT BE ACCEPTED, AND YOUR SCORE WILL BE ZERO.
No questions asked.

3. Students are expected to take all online exams during the
scheduled window of times. If you miss an exam, it is the student's
responsibility to notify the instructor, so that he may make
arrangements. YOU MUST MAKE PRIOR ARRANGEMENTS
WITH YOUR INSTRUCTOR TO MAKE UP AN EXAM - DON'T
JUST E-MAIL AND EXPECT TO GET A MAKE-UP EXAM. The
exam must be made up within 1 week.

4. Exams and homework assignments in this course are largely
based on lecture and lab material presented in class.

5. In the event that Internet access is not available to a student, for
whatever reason, he/she is still responsible for course material, or
information regarding schedule changes that were covered during
the week’s posted learning module. Be sure to contact a fellow
student to find out what you missed during your absence.

6. Students are expected to participate in online discussions and
MUST login to the course via the BlackBoard course management
system a minimum of three (3) times per week. Less than three
(3) logins constitutes less than adequate time to be successful in
the course.

7. You must make a face-to-face appointment with the instructor to
discuss grades. Do NOT e-mail and inquire about grades. |
cannot respond due to privacy considerations.



8. Although presented in an online format, this course is NOT
synchronous (i.e., where everyone logs in at the same time).
Everyone works on a weekly schedule of activities. Students learn
during their own time, but are expected to meet weekly deadlines
during the course (assignments, discussion questions, discussion
responses, etc.).

INTERNET AVAILABILITY OF CLASSROOM HANDOUTS: Course materials
for this course are posted on the Internet. Students of this class will be able to
access, read, and/or print the materials from home or from any place where you
are using a computer with Internet access capability. (All EImhurst students have
access privileges to use the computers at the College, under certain time and
printer restrictions.)

Course web site: http://bb.elmhurst.edu/
Textbook website: http://www.ametsoc.org/amsedu/login.cfm
Username: elmh248
Password: wx09fall
EVALUATION METHODS: Your course grade will be based upon a numerical
points system for: THESE ARE APPROXIMATE - MAY CHANGE!
1) Bio Post and BlackBoard Quiz (48 points)
2) Module Exams (100 points X 4= 400 points)
3) Comprehensive Final Exam (100 points)
4) Lab Assignments (20 X 10 = 200 points), lab assignments
5) Class Participation: CTQs (120 points)
6) Class Participation: Posted Responses (72 points)

for a total of approximately 940 possible points.
Breakdown of Points: Exams=54%; Class Participation/Discussion=21%; Labs=20%; Bio Post/BlackBoard Quiz=5%

Class Participation and Preparation:

Students will be assessed by the instructor on their level of participation and
online response through online discussion questions (“Critical thinking questions”
or CTQs). Included in this evaluation will be the level and quality at which
students participate in online class discussions, cite reference sources, ask
pertinent questions, and ask germane follow-up questions while supplying
thought-provoking responses. This is a lab course and is designed as a practical
hands-on experience. Your input and participation is important for both you and
your fellow students - don't let them or yourself down. A student who does not
actively participate in classroom activities and discussions can expect an
average final grade of a "C" at best.

Dates Exams must be completed by:

Exam I (Chapters 1-4, 9, & Geography): Saturday, Sept. 26 , by 6:00 PM
Exam II: (Chapters 5-8): Saturday, Oct. 10, by 6:00 PM

Exam IlI: (Chapters 10-12): Saturday, Oct. 31, by 6:00 PM

Exam IV: (Chapters 13-15 and App. Ill): Saturday, Dec. 5, by 6:00 PM
Comprehensive Final Exam: (Ch. 1-15, App. lll): Friday, Dec. 18, by 6:00 PM



http://www.ametsoc.org/amsedu/login.cfm

Note: All Module Exams are to be completed online by individuals (no group
efforts) and are due on Saturdays at 6:00 p.m. (NO EXCEPTIONS!) Final Exam
due on Friday of Finals Week (by 6:00 PM).

Letter grades for individual assignments are meaningless - only the total number
of points earned count toward your final tally for the course grade. Final letter
grades will be based upon a scale:

(89.5%=A, 79.5%=B, 69.5%=C, 59.5%=D, <59.5%=F).

You must earn at least 59.5% of the possible 930 points in order to pass the
course. Exams will consist of multiple-choice questions involving critical thinking
and analysis of maps/diagrams. Lab exercises will emphasize map/chart
interpretation with practical "real-life" cases. There are no makeup exams
because of the online format of this course.

In the past, some students have experienced technical difficulties with
computers, the BlackBoard System, etc., especially during the online exams. My
advice is the following:

e As asafeguard, when you begin the exam, highlight the entire exam with your
cursor, copy it, and paste it into Microsoft Word or Notepad. Then, save the file
as an .rtf file or .docx file. At least you will have a backup in case something
happens. | WILL accept this in lieu of the online exam. You may use this
method one (1) time only during the semester as an “emergency”. The second
time is a “0” on the exam.

e Dial-up Internet Service, Netscape, and AOL are somewhat unstable with
BlackBoard, so avoid using those if possible. Suggestion: Internet Explorer 7.0+
or Mozilla Firefox 2.0+.

e Do NOT click on the "back" button during the online exams or the system will
reset and you will be locked out. There are no “resets” for this.

e You may NOT confer with others in your class or group during the exam, but are
allowed to use any books, notes, PowerPoint lectures, or other reference
sources which were used in class. External websites, if not noted in class,
should not be trusted.

¢ Close all other software applications and "pop-up blocker" software during the
exam.

e Always click on “Submit” (NOT “SAVE”) after completing the exam.

e Oftentimes, several students may be working on the online exam
simultaneously. Therefore, the BlackBoard system slows down. Be patient and
give it a few minutes. Best practice: leave yourself 5 hours to take the exam
and don’t wait until Saturday afternoon.

HOMEWORK ASSIGNMENTS:

Because a science course requires you to learn a great deal of new vocabulary,
your homework will consist of reading the associated chapters in the textbook as
well as lectures on the CD and on the BlackBoard site. Itis to your advantage to
read the chapters as we discuss them online not waiting until the exam is posted
to read all the covered chapters.



OTHER COURSE INFORMATION

Elmhurst College will make reasonable accommodations for persons with documented
disabilities. If you have a disability, which may have some impact on your work in this course,
please contact Ms. Maureen Connolly, Learning Center, Frick Center, (630) 617-3753.

Elmhurst College does not discriminate on the basis of race, color, creed, religion, national origin,
disability, age, sex, sexual orientation, or marital status in admission to and participation in its
education program, College activities and services, or employment practices. The College does
not tolerate sexual harassment or sexual assault by or of its students or employees.

Other Information:
The following are a few key points to remember as part of this class:

1.

| do NOT respond to e-mail regarding grades because of privacy reasons.
You must visit me face-to-face to discuss anything having to do with grades.

Anything that is turned in for grading must be completed individually.
Obviously, you may work with your fellow students on exercises and/or
assignments, but each student hands in their own assignments. Most of the
time, responses will be typed and submitted online via a “drop box”. However,
in the event that something is hand written, neatness counts! If the instructor
cannot read it, it is counted as wrong!

Calculators can be used for the minimal calculations that can be performed
but you must show equations and/or your work. Full credit will not be given
unless the work is present in the submission. Remember also that most
calculations must have units attached.

Report any computer access problems with machines on campus (not
personal computers) immediately to the instructor.

A detailed schedule of dates, course lecture topics, associated textbook
chapters, videos, lab assignments, and lecture notes are posted on the
Internet at:

Course web site: http://bb.elmhurst.edu/
Your textbook website also includes valuable information:
Textbook website: http://www.ametsoc.org/amsedu/login.cfm
Username: elmh248 Password: wx09fall



http://www.ametsoc.org/amsedu/login.cfm

Tentative Schedule as of 8/31/09:

Week Dates Topic Text Assignments Due Dates Points for
Chapter Each
Module
Mandatory » Bio post due 48
Meeting — Introductions, » Post bio on by Thursday,
Mon., Aug. 31 Syllabus, Discussion Sept. 3 at 6:00
6:00 p.m. Online Course forum entitled, p.m.
1 SC 003 Format, “Bio” (16 points) » BlackBoard
Share contact »Read quiz due by
Module 1: Info. BlackBoard Sat., Sept. 5 at
Aug. 31-Sept. 5 Pay technology tutorial and take | 6:00 p.m.
fees online » Respond to
Distribute CDs BlackBoard quiz | at least three
Module #1 (32 points) ES)gio psosts .
) y Sat. Sept.
assignments at 6:00 PM
» Read text- » Answer 36
based lecture(s) | assigned
» Read CTQs by
PowerPoint Wednesday,
Lecture(s) Sept. 9 at 6:00
1. AMS » Answer p.m.
PPT assigned critical » Respond to
Intro. to Science Lecture thinking at least three
of guestions (3) different
Geography/Maps, | 2. Text- (CTQs) in the CTQs by
2 Module 2: Monitoring the Based appropriate Saturday,
Sept. 7-Sept. 12 Weather Lecture threaded Sept. 12 at
(on CD) discussion forum | 6:00 p.m.
» Respond to at »Lab 1 due
3.Ch. 1 least three (3) by Saturday,
in CTQs by others Sept. 12 at
Textbook | »Lab 1: 6:00 p.m.
Latitude/Long. »Lab 2 due
»Lab 2: by Saturday,
Isoplething Sept. 12 at
6:00 p.m.
36
» Read text-
based lecture(s)
» Read » Answer
PowerPoint assigned
Lecture(s) CTQs by
1. AMS » Answer Wednesday,
PPT assigned critical | Sept. 16 at
Lecture, thinking 6:00 p.m.
guestions » Respond to
Module 3: Atmosphere: 2. Text- (CTQs) in the at least three
Sept. 14- Origin, Based appropriate (3) different
3 Sept. 19 Composition, and Lecture threaded CTQs by
Structure (on CD) discussion forum | Saturday,
»Respond to at | Sept. 19 at
Solar and 3.Ch.2 least three (3) 6:00 p.m.
Terrestrial in CTQs by others »Lab 3 due
Radiation Textbook | »Lab 3: by Saturday,
Temperature Sept. 19 at
4.Ch. 3 and Lapse 6:00 p.m.
in Rates »Lab 4 due
Textbook | »Lab 4: by Saturday,
Universal Sept. 19 at
Coordinated 6:00 p.m.

Time Lab




» Read text-

based lecture(s) » Answer 116
1. AMS » Read assigned
PPT PowerPoint CTQs by
Lecture, Lecture(s) Wed., Sept. 23
» Answer at 6:00 p.m.
Heat, 2. Text- assigned critical » Respond to
Temperature and Based thinking at least three
Atmospheric Lecture guestions (3) different
Circulation, (on CD) (CTQs) in the CTQs by Sat.,
appropriate Sept. 26 at
Module 4: Planetary 3.Ch. 4 threaded 6:00 p.m.
Sept. 21- Circulation: El in discussion forum | »Exam | due
Sept. 26 Nifio and La Nifia | Textbook | »Respondtoat | by Saturday,
least three (3) Sept. 26 at
4.Ch.9 CTQs by others 6:00 p.m.
Exam | in » Take Online » NO labs this
Textbook | Exam | (includes | module
Ch. 1-4, 9, plus because of
Geography and Exam |
Maps)
» Read text- » Answer 46
based lecture(s) | assigned
» Read CTQs by
PowerPoint Wednesday,
Lecture(s) Sept. 30 at
» Answer 6:00 p.m.
assigned critical » Respond to
thinking at least three
guestions (3) different
(CTQs) in the CTQs by
appropriate Saturday, Oct.
threaded 3 at 6:00 p.m.
discussion forum | »Lab 5 due
1. AMS »Respond to at | by Saturday,
PPT least three (3) Oct. 3 at 6:00
Lecture, CTQs by others p.m.
»Lab 5: »Lab 6 due
2. Text- Investigation 1A | by Saturday,
Based (Air Pressure Oct. 3 at 6:00
Lecture and Wind) in p.m.
(on CD) your lab manual »Lab 7 due
(including by Saturday,
Module 5: Air Pressure 3 Ch.5 applicati_ons) Oct. 3 at 6:00
Sept. 28-Oct. 3 Wind in >Lab6: p-m.
Textbook | Investigation 1B
(Surface Air
4.Ch. 8 Pressure
in Patterns) in your
Textbook | lab manual
(including
applications)
»Lab 7:
Investigation 2A
(Surface
Weather Maps)
in your lab
manual
(including

applications)




» Read text- » Answer 116
based lecture(s) | assigned
» Read CTQs by
1. AMS PowerPoint Wednesday,
PPT Lecture(s) Oct. 7 at 6:00
Humidity, Lectures | »Answer p.m.
Saturation, and assigned critical » Respond to
Stability 2. Text- thinking at least three
Module &: Clouds, Based question_s (3) different
Oct. 5-Oct. 10 Precipitation, and Lectures | (CTQs) in the CTQs by
Weather Radar (on CD) appropriate Saturday, Oct.
Exam Il threaded 10 at 6:00
3.Ch.6 discussion forum | p.m.
in »Respond toat | » Exam Il due
Textbook | least three (3) by Saturday,
CTQs by others Oct. 10 at 6:00
4.Ch. 7 » Take Online p.m.
in Exam Il » NO labs for
Textbook | (includes Ch.5- | this module
8) because of
Exam II.
» Read text- 46
based lecture(s)
» Read
PowerPoint
Lecture(s)
» Answer
assigned critical
thinking
questions
(CTQs) in the
appropriate » Answer
1. AMS threaded assigned
PPT discussion forum | CTQs by
Lecture, »Respond to at | Wednesday,
least three (3) Oct. 14 at 6:00
Weather Systems | 2. Text- CTQs by others p.m.
Module 7: of Midlatitudes Based »Lab 8: » Respond to
Oct. 12-Oct. 17 (Mid-Latitude Lecture Investigation 4A | at least three
Cyclones) (on CD) (Temperature (3) different
and Air Mass CTQs by
3. Ch. 10 | Advection)in Saturday, Oct.
in your lab manual | 17 at 6:00
Textbook | (including p.m.
applications) »Lab 8 due
»Lab 9: by Saturday,
Investigation 4B | Oct. 17 at 6:00
(Heating p.m.
Degree-Days »Lab 9 due
and Wind Chill) by Saturday,
in your lab Oct. 17 at 6:00
manual p.m.
(including »Lab 10 due
applications) by Saturday,
»Lab 10: Oct. 17 at 6:00

Investigation 6A
(Clouds,
Temperature,
and Air
Pressure) in
your lab manual
(applications
only pp. 6A5-
6A10)

p.m.




» Read text- 46
based lecture(s)
» Read
PowerPoint
Lecture(s) » Answer
» Answer assigned
assigned critical | CTQs by
thinking Wednesday,
questions Oct. 21 at 6:00
(CTQs) in the p.m.
appropriate » Respond to
1. PPT threaded at least three
Lecture, discussion forum | (3) different
»Respondtoat | CTQs by
2. Text- least three (3) Saturday, Oct.
Module 8: e  Thunderstorms Based CTQs by others | 24 at 6:00
Oct. 19-Oct. 24 and Tornadoes Lecture »Lab 11: p.m.
(on CD) Investigation 7A | »Lab 11 due
(Precipitation by Saturday,
3. Ch. 11 | Patterns)inyour | Oct. 24 at 6:00
in lab manual p.m.
Textbook | (including »Lab 12 due
applications) by Saturday,
»Lab 12: Oct. 24 at 6:00
Investigation p.m.
11A »Lab 13 due
(Thunderstorms) | by Saturday,
in your lab Oct. 24 at 6:00
manual p.m.
(including
applications)
»Lab 13:
Investigation
11B (Tornadoes)
in your lab
manual
(including
applications)
» Read text- 136
based lecture(s)
» Read » Answer
PowerPoint assigned
Lecture(s) CTQs by
» Answer Wednesday,
assigned critical | Oct. 28 at 6:00
thinking p.m.
questions » Respond to
1. AMS (CTQs) in the at least three
PPT appropriate (3) different
Lectures | threaded CTQs by
discussion forum | Saturday, Oct.
2. Text- »Respond toat | 31 at 6:00
e  Tropical Weather Based least three (3) p.m.
Module 9: Systems Lecture CTQs by others » Lab 14 due
Oct. 26-Oct. 31 | 4  Exam Il (on CD) »Lab 14: by Saturday,
Investigation Oct. 31 at 6:00
3.Ch.12 | 12A p.m.
in (Hurricanes) in » Lab 15 due
Textbook | your lab manual by Saturday,
(including Oct. 31 at 6:00
applications) p.m.
»Lab 15: » Exam Il
Investigation due by
12B (Hurricane Saturday, Oct.
Wind Speeds 31 at 6:00
and Pressure p.m.
Changes) in
your lab manual
(including

applications)




» Take Online
Exam Il

(includes Ch.
10-12)
» Read text- 36
based lecture(s)
» Read » Answer
PowerPoint assigned
Lecture(s) CTQs by
» Answer Wednesday,
assigned critical Nov. 4 at 6:00
thinking p.m.
guestions » Respond to
1. AMS (CTQs) in the at least three
PPT appropriate (3) different
Lecture, threaded CTQs by
discussion forum | Saturday, Nov.
2. Text- »Respondtoat | 7 at6:00 p.m.
Module 10: e Weather Analysis | Based least three (3) »Lab 16 due
10 Nov. 2-Nov. 7 and Forecasting Lecture CTQs by others by Saturday,
(on CD) »Lab 16: Nov. 7 at 6:00
Investigation p.m.
3.Ch. 13 | 13A (Weather »Lab 17 due
in Instruments and | by Saturday,
Textbook | Observations) in | Nov. 7 at 6:00
your lab manual | p.m.
(including
applications)
»Lab 17:
Investigation
13B (Weather
Forecasts) in
your lab manual
(including
applications)
» Read text- » Answer 16
based lecture(s) | assigned
» Read CTQs by
1. AMS PowerPoint Wednesday,
PPT Lecture(s) Nov. 11 at
Lecture, » Answer 6:00 p.m.
Module 11: e  Climate and assigned critical | »Respond to
11 Nov. 9-Nov. 14 Climate Change 2. Text- thinking at least three
’ ' Based questions (3) different
Lecture (CTQs) in the CTQs by
(on CD) appropriate Saturday, Nov.
threaded 14 at 6:00
3. Ch. 15 | discussion forum | p.m.
in »Respond toat | »NO labs for
Textbook | least three (3) this module
CTQs by others
» Read text- » Answer 36
based lecture(s) | assigned
1. AMS » Read CTQs by
PPT PowerPoint Wednesday,
Lecture, Lecture(s) Nov. 18 at
» Answer 6:00 p.m.
2. Text- assigned critical » Respond to
Based thinking at least three
. Lecture questions (3) different
12 No%u « Climate (onCD) | (CTQs)inthe | CTQs by
: : Classification appropriate Saturday, Nov.
3. threaded 21 at 6:00
Appendix | discussion forum | p.m.
] »Respond toat | »Lab 18 due
(Climate least three (3) by Saturday,
Classific CTQs by others Nov. 21 at
ation) in »Lab 18: 6:00 p.m.
your Investigation »Lab 19 due
Textbook | 15A (Visualizing | by Saturday,




Climate) in your Nov. 21 at
lab manual 6:00 p.m.
(including
applications
»Lab 19:
Investigation
15B (Local
Climate Data) in
your lab manual
(including
applications
» Read text- 16
based lecture(s) | »Answer
» Read assigned
PowerPoint CTQs by
1. PPT Lecture(s) Wednesday,
Lecture, » Answer Nov. 25 at
. assigned critical | 6:00 p.m.
13 N Module 13: Atmospheric 2. Text- thinking » Respond to
ov. 23-Nov. 28 - )
Optics Based questions at least three
Lecture (CTQs) in the (3) different
(on CD) appropriate CTQs by
threaded Saturday, Nov.
3. Ch. 14 | discussion forum | 28 at 6:00
in your »Respondtoat | p.m.
Textbook | least three (3)
CTQs by others
»Lab 20: »Lab 20 due 100
Investigation by Saturday,
14A (Optical Dec. 5 at 6:00
Phenomena) in p.m.
your lab manual »Exam IV
14 Module 14: (including due by
Nov. 30-Dec. 5 Exam IV applications) Saturday, Dec.
» Take Online 5 at 6:00 p.m.
Exam IV
(Includes Ch.
13, 14, 15, and
Appendix 111)
Online » No reading 0
Discuss./Debate: assignments
15 Module 15: Global Climate » Global climate
Dec. 7-Dec. 12 Change change posts
Study for Final
Exam
» Complete 100
online course
Chapters | »Complete the evaluation by
; . Cumulative 1-15, online course Friday, Dec.
16 Dm FINAL EXAM Appendix | evaluation 18 at 6:00 PM
ec. 14-Dec. 18 .
] » Final Exam
due by Friday,
Dec. 18 at
6:00 p.m.

**Final Course Grades will be posted on the BlackBoard and BlueNet sites

by Mon., Dec. 21, 2009




Online Learning Readiness
Online learning is an exciting way to learn that offers an unparalleled combination of flexibility and interactivity. We have
worked hard to ensure that your experience will be positive, but we also know that for the beginner, taking a course online
can be a daunting prospect. We have put together this guide to help prepare you for learning online. Even if you have
taken a course online, you may find some new material here. We hope that you, too, will take the time to read this
material.

Here is what you will find in this document:

e An overview of online learning, including a definition of online learning and comparisons between online
and traditional courses.

e  Computer basics: answers to questions that are general in nature and that pertain specifically to taking
courses online

The qualities of a successful online learner
Study suggestions for the successful online learner
A brief guide to participating in discussion forums

We hope that you find this information useful. If you think of anything else you believe we should have included in this
document, please let us know at richs@elmhurst.edu

Online learning — an overview

What is an “online course?”

An online course is a course that uses the Internet to deliver course material to your computer. Online courses are
available 24 hours a day, every day. In an entirely online course, there are no class (face-to-face or “f2f’) meetings. All
work will be submitted online via the Internet and most interactions between class members and instructors will take place
online, via discussion forums or email.

What are the differences between online courses and on-campus (sometimes called on-ground or “brick and
mortar”) courses?

Online classes require more involvement on the part of student than traditional classes. In an on-line course, there is no
“back row” in which students can sit quietly and take notes. In an online class, students are constantly involved in the
learning process. Some students find that online classes require much more self-discipline than regular classes. Since
there is no class to attend, it can be easy to avoid sitting down in front of the computer to work.

Unlike traditional classes, with online learning you can “go to class” any time. Of course, no one is going to see you if you
raise your hand. To communicate you must email your instructors, or, if the instructors are willing, contact them by phone.
Advantages to online learning include:

Advantages of learning online:

Flexible schedule

No driving or taking the bus to class, saving you money

You can learn new computer skills

You often get the chance to work with people from various geographical locations
You will develop your non-verbal communication skills

Computer basics
In this section, you will find helpful information concerning the general use of computers and the Internet, and material

about computer use that pertains directly to courses offered via the web.

An “ISP” is an ‘Internet Service Provider’, which provides Internet access to companies or individuals. An ISP maintains
connections to other networks and ISPs, and acts as a “router” for Internet traffic between a customer's computer and any
other machine also connected to the Internet anywhere else in the world. Your computer needs to have Internet access to
access your course.

What kind of computer do | need?

You need a computer capable of accessing the Internet. Unless your computer is rather old, in all likelihood it will have a
modem and will have a built-in Ethernet card. The latter will allow your computer to access the Internet at higher speeds
than by modem (if you have signed up for high speed access with your Internet service provider).

You can use either a Macintosh or a PC with the appropriate Internet browser installed (see below). Macs and PCs all
come with browsers pre-installed. Specifically, student computer systems for our online courses must be able to run at
least Internet Explorer 7 (on a multimedia PC or Mac that includes a sound card, speakers, at least a 24x CD-ROM drive
and a color monitor, 15" or larger. Other web browsers should work, but we cannot ensure compatibility. This usually
requires at least a Pentium PC or a Power PC Macintosh. Minimum computer memory required is 256 MB RAM but more
is preferable. Participants need access to the Internet with a minimum speed of at least 56.6 kps. A small color printer is
also useful, but not required.

Students are responsible for purchasing, installing and maintaining all computer hardware and software required for their
participation in these online courses.



Note too that in order to provide for a quality learning experience, you need more frequent computer access than can be
provided by going to an “Internet café”.

You must be able to turn your computer on and off, use a mouse, know how to start and end programs, create, open and
save files, and use a web browser. Note that it is NOT the responsibility of your instructor or the Department of Geography
and Geosciences to teach you these skills. If you do not have the required computer skills, find someone who can teach
you these skills before you start the course or perhaps this course is not for you.

In addition to the above, you should also remember that you will be required to do a considerable amount of typing for
your online courses. You do not have to be a keyboard maestro to enjoy the course, but be aware that if it has been a few
years since you have done any typing, it may take a while for you to feel comfortable with the computer keyboard. If you
would like to practice your typing, you can use online typing tutoring available at http://www.learn2type.com

In all likelihood, you will be using a Windows systems or Macintosh (OS 9 or X). Software requirements for online courses

are minimal, but there are some programs that you must have to complete your course. You will need:

1) A web browser. A web browser contains the software that enables you to find, retrieve, view, and send information over
the Internet. See “What kind of a computer do | need?” above for a discussion of which browsers will work well and
how to get one.

2) A word processor. A word processor is software that enables you to create and format text documents, such as essays.
There are a number of word processors available. Many computers come with a word processor already installed.
Microsoft “Word” is the most widely used word processor. A number of PCs come with Word installed. Some of you
may have Corel’'s “Word Perfect”, which is also fine. Macintosh users may have a program called “Appleworks”
installed. Microsoft Word is also available for the Macintosh. There are other word processors available, but the most
important ability your word processor must have is the ability to save file in "rtf" (rich text format). It is a format for
saving a text document that allows you to retain most of your layout and formatting even though you can't be sure
what computer configuration is being used on the receiving end.

If you are not sure that your word processor can save files in .rif, see “My instructor wants me to submit an
assignment in .doc, or .rtf format, or as a last resort, as a PDF. What does this mean?” below.

3) Presentation software. Some courses may require you to view (and possibly create) presentations created in Microsoft
“PowerPoint.” Many computers come with PowerPoint pre-installed. Macintosh users will have to purchase
PowerPoint, or can use Apple’s “Keynote” (you must purchase Keynote) to read PowerPoint presentations.

PC users who do not have or wish to purchase PowerPoint, can currently download a free PowerPoint 2007 viewer
from Microsoft at: http://www.microsoft.com/Downloads/details.aspx?familyid=048DC840-14E1-467D-8DCA-
19D2A8FD7485&displaylang=en

General Information

e A browser is a computer program used to access the World Wide Web. Common browsers are Internet
Explorer, Netscape, both of which are currently available for both PC and Macintosh platforms. Safari is
Apple’s web browser. If you are having difficulty accessing pages or files on the net using Safari, try using
one of the other browsers mentioned above. Note also that some functions in BlackBoard may not work
well in Safari. Netscape for the Mac is available at http:/channels.netscape.com/ns/browsers/default.jsp .
Internet Explorer for the Mac is available at http://www.microsoft.com/mac/ .

What is an email client?

e  An email client is the program used to send and receive email. Examples of email clients include Google’s
G-Mail, Microsoft’s “Outlook,” “Outlook Express”, and “Entourage,” Apple’s “Mail”, Netscape’s “Mail,” and
“Eudora”.

Note: some of you may not use a separate program to read your email, but instead use a web-based email
service such as Hotmail or Yahoo! Mail. If you are having trouble accessing your email or sending
attachments, consider using one of the above clients.

e You might occasionally come across the term “interface.” An interface is a device or a system that allows
two unrelated entities (in this case, you and your computer) to interact in some way. To allow you to tell
your computer to do something, programmers include an “interface,” which for the majority of home users
is the kind of interface called “a graphical user interface or GUI (pronounced “gooey”).” When you use your
computer’'s mouse to “push” buttons that are visible on your computer’s screen, you are using an interface.

What’'s a URL?
e An URL is a web address. URL stands for Universal Resource Locator. It is a unique address on the
Internet and is composed of at least three parts:
o  After the final slash, there can also be any number of directory names, and a file name. For example:
http://det.ubc.ca/detsite/home/whatsnew.html

o Note: if you enter a URL into your web browser, you must be precise. A URL must be spelled exactly.
You must also reproduce upper or lower cases exactly. You can also paste a URL into your browser.
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What is a bookmark and why are they useful?

e A *“bookmark” in a web browser is in fact your web browser’s way of recording the URL of a page on the
World Wide Web. As you open WebPages, you may want to bookmark them so that you can quickly return
to them. By book marking a page you can easily go to it again by clicking a bookmark icon in the Personal
Toolbar or Bookmarks menu (Netscape), choosing it from the Bookmark menu bar (Safari), or by choosing
the bookmark's name from the Favorites menu (Internet Explorer).

e  To bookmark a webpage, open the page, and then choose Add Bookmark (or Add Page to Favorites) from
the Bookmarks or Favorites menu. You can also click the Add Bookmarks/Favorites button in the address
bar, if it is showing.

. Downloading a file from the Internet, like a picture or document, means you are creating a copy of the file
down from the Internet to your computer. It may help if you think of the Internet as being physically higher
than your own computer. This makes it easier to visualize downloading.

e How do | copy and paste?

o  Using the mouse, select the text (usually holding down the left mouse button), graphic, or picture you
want to copy and choose Copy from the Edit menu. Choose where you want to paste the item by
clicking your mouse to place the cursor and choose Paste from the Edit menu.

Course Related

Do | need an email address to take this online course? Yes! You need to have an Elmhurst College email address so that
your instructor (and others in the class) can contact you, if need be. If you are an EC student, you should already have an
email account. Of course, you may always forward that EC e-mail address (mailbox) to your personal mailbox. If you have
Internet access, then your ISP (Internet Service Provider) likely provides you with an email account. There are also free
web-based email services, such as Google (Gmail), Hotmail, or Yahoo! Mail.

IMPORTANT: You MUST forward your EC e-mail address (if you are not using the EC e-mail address). Go here:
http://public.elmhurst.edu/elmhurststudents and then type in your Elmhurst Technology account username and password
to forward your e-mail.

You can access your course from any computer that has an Internet connection as long as you know your BlackBoard
user id and password and the URL for the BlackBoard site (http://bb.elmhurst.edu ).

The importance of logging in yourself

It is important that you log into the course using your own user id and password. If you and a friend are taking the same
course, you should NOT access the course from your friend’s computer without logging in to the course using your own
user id and password. Otherwise, every post you make on a discussion forum will be under your friend’s name, not yours.

Can | download the entire course to my computer and work on materials when my computer is not connected to
the Internet?

In a word, “NO.” You can compile course content and read it when your computer is not connected to the Internet, but you
cannot do anything requiring any interactivity (engaging in discussions, chats, or linking to external URLS) without
physically logging into the course online.

As tempting as it is to dive right into the course without reading this material, you should read it. You can avoid
considerable frustration and needless time on the phone to BlackBoard support by reading this material. It can increase
your enjoyment of the experience of learning online. Even if you are an old hand at online learning, knowing what is in this
section can help to aid other classmates who may not be as experienced as you are.

Why do | need Adobe’s “Reader” for PDFs and, for that matter, what is a PDF?

You may be required to read PDFs for a particular module. Adobe PDF is a format for electronic document exchange that
preserves document integrity so that files can be viewed and printed on a variety of platforms, such as Windows and
Macintosh. “Adobe Reader” is free software that lets you view and print Adobe Portable Document Format (PDF) files on
a variety of hardware and operating system platforms. There is a good chance that your computer already has Adobe’s
Reader installed, but if it doesn'’t, use this link to get it: http://www.adobe.com/products/acrobat/readstep2.html . Follow
the instructions once you get to the web page.

My instructor wants me to submit an assignment in.docx, or .rtf format, or as a last resort, as a PDF. What does
this mean?

If you create documents in Microsoft Word 2007, you do not have to worry about creating a document in the “.docx”
format, since that is Word’s default file format. If you are using WordPerfect or AppleWorks, you can save your document
either as a Word document, or in a format known as “rtf” (Rich Text Format). Otherwise, your instructor may not be able to
open it. If you are using Office or Word 2003, please download and install the Compatibility Patch so that you can read
.docx files: http://www.microsoft.com/downloads/details.aspx?familyid=941B3470-3AE9-4AEE-8F43-
C6BB74CD1466&displaylang=en Elmhurst College officially uses Office 2007.

To save a document in Rich Text Format (.rtf), do the following:

1. Create or open your document.

2. Select Save As from the File Menu.

3. A window will appear prompting for a file type and destination to save the file.
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4. Click the File Type pull-down menu and select Rich Text Format.

5. Verify that the file name and Destination is correct and click Save.

6. Most word processing programs can now read your document.

This process works for most word processing documents. However, it does not always work for files with a great deal of
graphics or column formatting.

When saving a file as an .rtf does not work well, you might consider saving your document as a PDF, if your instructor
approves. If you are using Windows, you need Adobe’s Acrobat, which you also need to buy. If you are using a Macintosh
and are running OS X, you can save files as PDF from within any program. This is a very simple process:

1. With the document open, choose Print from the File menu

2. Click Save As PDF.

3. Type a name for the document and choose where you want to save it.

4. Click Save.

If you are using a specific email client, to attach a document to an email message, do the following:
1. Start up a new message.
2. After typing in the recipient info and subject, select the “attach document” (or “attach” or “add attachment”) option
from the selection of buttons that appears near the top of your new message window.
3. A special window will open. From this window choose the document you wish to attach and click ok. You may
have to “browse” to locate your document.
4. When you send the mail message, the document will be sent with it.

The qualities of a successful online learner
What does it take to be a successful online learner? In many ways, the qualities that will lead to success are the same as
those required to succeed in many other endeavors:
General qualities

* determined

« flexible

* positive outlook

« self-motivated

* able to work alone

« ability to follow instructions

« able to meet deadlines

« ability to communicate in writing

« ability to work with others to complete projects
« willing to ask for help when necessary

Technology-related
* possess, or be able to learn, basic skills required to operate a personal computer

« able to work with new technology

+ able to use, or to learn how to use, email, including attaching files

« ability to search the web

» ability to copy and paste text or graphics from one program to another

Other Tips:

Study suggestions for the successful online learner

. Effective time management is a must.

You must be able to determine - and follow - a realistic schedule to complete your assignments. Do not
procrastinate! It is very easy to fall behind when you do not have to physically attend a class. Once you fall behind,
it can be very difficult to get caught up. Get help when you need it. Resolving problems at a distance without the
means that exist in a regular classroom can be challenging. Be sure to make use of the BlackBoard Support/help
desk, available online.

e  Research and writing skills are crucial for online classes. Knowing how to effectively research using the Internet and
libraries and having strong writing skills are important.

e  Knowing how to correctly cite materials taken from Internet published work. This course uses the APA format. Learn
about the APA style of citation here: http://www.elmhurst.edu/library/ecresources/writecite.html

e  The ability to work well cooperatively is an important skill. Many online classes require learners to participate in
collaborative learning activities. Participate actively. Do the various learning activities, and participate in the
discussion as much as you can in order to get the most out of a course.

e  Remember, technology is far from perfect. If you lose your Internet connection, you may lose your work. Type and
save all writing assignments in a word processor. By doing this, you have the ability to copy and paste into the
message box or to attach the document to an email. It is also a very good idea to print out all your assignments as
backup.
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Course Rubric: Discussion (Critical Thinking Questions)

Evaluation
Criteria

Advanced
(9-10 pts)

Proficient
(6-8 pts)

Average
(4-5 pts)

Below Average
or Non-Existent

(0 pts)

Development

Well-developed ideas;
introduces new ideas;
stimulates discussion;

Developing ideas;
sometimes stimulates

Poorly developed
ideas, which do not
add to discussion,

Does not enter the
discussion or posted in

treatment, and
relevance characterize
postings. Sometimes
include unusual
insights. Arguments are
well supported.

analysis and creative
thought. Tendency to
recite facts rather than
address issues.

of Ideas . discussion, posted in .
posted in correct mostly posted in wrong thread.
correct thread.
thread. correct thread.
Clear evidence of
critical thinking--
application, analysis, Beginnings of critical
synthesis and thinking; postings tend
evaluation. Clarity of to address peripheral
BidEnE af argument, depth of issues. Generally
Critical insight into theoretical |accurate, but could be [Poorly developed Does not enter the
Thinking issues, originality of improved with more critical thinking discussion

Response to

Interacts at least three
times with other

Interacts 1-2 times with

sources. Does NOT
use Wikipedia.org as a
reference cited.

does not cite correctly.
Wikipedia.org used as
a citation source
without corroboration
from other non open
source sites.

Other students and/or other students and/or [Little interaction with |Does not enter discussion
Students and |instructor with clarity instructor with some no insight. (1-2 pts.) |(0 pts.)
Instructor  |and thought-provoking [insight. (3-4 pts.)
analysis. (5-6 pts.)
Effectlve!y . Interacts with partner .
communicates with . Rather poor in terms
mostly well, but in L
partner and . of communication. _ I
- ... |collaboratively provides ML ECES Partners do not post ocSLicationiag
Working with a well-thought out communication breaks together so overall and each partner posts
Assigned [~ . 9 down. Each partner geth separately or not at all. No
individual response. meaning of J
Partner almost always labels 5 . |evidence whatsoever of
Each partner correctly " collaborative work is 5 2
; ?  [their response(s) collaborative learning.
and plainly labels their .. [lost. Two separate
: ; correctly and plainly in
response(s) in a single h posts may result.
the single post.
post.
Individual message and |Individual message
: n at least two responses |posted before Postings made after
eliess posted before deadline |deadline, but not both |the deadline e
responses
Does not cite at all. This
Cites correctly most of consitutes pla_glansm
> : . and student will be
the time using APA Hardly ever cites
: warned once. The
Correctly uses APA Sl Indlljde.s e correctlyl using theh second offense is
Citation Style and (&) el cngd P e, LESE L) punishable by a “0” on the
A sources. Sometimes three (3) sources A
includes more than uses MLA Stvle or used. Uses assignment and a
Citation three (3) correctly cited Y . discussion with the

Wikipedia.org as a
source without
corroboration from
other non open
source sites.

instructor as well as
referral to the College
Dean. The third offense is
punishable by failing the
course and a referral to
the College’s Disciplinary

Board.

Critical Thinking Questions (CTQs) are a major part of this course. Each weekly module includes one
guestion worth ten (10) points assigned to each student (or group of students) in which a detailed response
is posted by the student(s) in the correct discussion thread. Students must post their individual response to
the question on time and reply (comment on) to others’ responses by the end of the module. Timely
interaction is most important. Class participation is what makes this work for everyone in the course.



Welcome to Meteorology 101-52 Online
"Introduction to Meteorology"

THIS CLASS IS NOT EASY! It will require self-discipline and dedication on your part. Many will
enroll -- most will pass (but not all). OK - now that | have your attention, let me explain...

NONE of the GenEd classes offered at EImhurst College are designed to be "easy" - or difficult
for that matter. You may find some classes easier than others (some students are science-phobic
for example). They are designed to give you an appreciation for the subject matter so that you
leave the course with some knowledge of that topic. There really is no correlation between
difficulty in a course and its course number. For example, 100-level courses can be more difficult
than 400-level course. GEO 101 is no exception.

Many students assume that an online class will be easier than a regular class - NOT TRUE! We
expect you to do JUST AS MUCH WORK as in a regular section. The only difference is that YOU
get to decide WHEN to do the work (i.e., at 6 am or at 11 pm), and you have some flexibility
about when you take the exams, etc. Keep in mind that there are weekly assignments and
discussion posts, this is NOT a course that you can wait until the last week (or later) to complete.

You should NOT expect to happily surf your way to easy credits - you still have to put in serious
hours to read the book, read the text-based lectures, do the lab exercises, study, answer the
assigned critical thinking questions, reply to others’ posts, and take the exams.

In a traditional “brick and mortar” 4-credit lab course, we expect and plan that you attend every
class (that's 5 hours per week), PLUS put in another 8-10 hours a week (2 hours outside of class
for every one hour in the classroom) reading and studying. The same is true with the online class
- YOU SHOULD BE PREPARED TO PUT IN A MINIMUM OF 13-15 HOURS PER WEEK TO
GET A DECENT GRADE (B OR BETTER). If you find your grade in this class slipping, ask
yourself if you're really putting in enough hours. Then, seek help from the instructor! | don't know
if you are struggling if you don't communicate with me. | am glad to help, but you must ask.

This Handout contains everything you need to know about how to succeed in this course.
READ THE ENTIRE Handout CAREFULLY!

About this course...

Welcome to METEOROLOGY 101-52 Online: Introduction to Meteorology. This is a class in
which we describe & explain Earth's Weather and Climate. We also discuss contemporary issues
such as greenhouse warming; the bone-chilling cold waves in Russia in recent years, the ozone
“hole”, air pollution etc. The course is primarily descriptive ... no excessive math or physics
background is needed (beyond what you had in high school), although there will be some simple
mathematical calculations in the lab assignments and in order to respond to discussion questions.



METEOROLOGY 101-52 Online covers the same material -- and carries the same workload -- as
the traditional “brick and mortar” lecture sections, but with the added flexibility of learning when it
is convenient for you. The learning experience in the online section is heightened by Internet
access to a wealth of current weather and climate data, provided by the American Meteorological
Society (AMS). This course is licensed — that means over 200 colleges and universities in the
U.S. are completing the same basic course, established by the American Meteorological Society
(AMS).

Successful completion of this course fulfills the General Education Requirement in IST, and is
certified by the EC General Studies under the General Education Guidelines. We have taken
every precaution to ensure a problem-free experience, but we fully expect to encounter a few
problems. Many of these are unique to the online teaching and learning experience. Student and
instructor flexibility are important tools for addressing online class problems should they arise. We
promise to make every effort to resolve any problem as quickly and fairly as possible.

Sincerely,
Richard B. Schultz, Ph.D.
Facilitator

Instructor Information:
Dr. R. B. Schultz

Fall 2009

Office: 316 Daniels Hall

Phone: (630) 617-3128

Email: richs@elmhurst.edu (best and quickest way to reach me)
You may send e-mail at anytime, and | check e-mail frequently on all days, but please be aware
that faculty workloads may not permit an immediate response. In other words, don't expect an
immediate response if you send a message at 3:00 a.m. Saturday morning! I'll do the best | can
to answer your e-mail as fast as | can.

Getting Started

e After Aug. 31, There are NO ON-CAMPUS MEETINGS!! We are 100% online!

e You will use your EImhurst College e-mail address assigned to you. You may use
your personal e-mail address as long as your Elmhurst College e-mail account is
forwarded to it.

e To access BlackBoard, use your EImhurst College username and password. If you
do not know your BlackBoard username and password, contact Linda Selvik at: (630)
617-3699.

¢ | must be able to contact you, and in this "virtual" class, the only way is by email!
| send out a number of important and interesting announcements and bits of
information by email - you will not want to miss these!

e | will also post on the course site under “Announcements”. BE SURE TO READ THE
“‘“ANNOUNCEMENTS” SECTION EVERY TIME YOU ACCESS THE SITE!!

Textbook

The following textbook is required:

Online Weather Studies (Textbook) and Investigations Manual 2009-
2010/Summer 2010: ISBN 13: 97818782200936 (packaged as a “bundle”)
Copyright 2007 American Meteorological Society.

If ordering from another source online, pay close attention to shipping time - you need the book
NOW - not in 2-3 weeks! You may also be able to find the text at a used bookstore that stocks
college-level texts.
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Be sure to get the 4th Edition. A student study guide for the text is also available (not required,
but recommended).

Computer Hardware and Software Requirements
The following minimum hardware is required:

Pentium-generation with at least 1 Gb of RAM (more is better)

Obviously, the above is for a Windows-type machine, but any newer Mac is fine too (e.g.,
iMac, G4 etc.)

56K modem or broadband Internet access. Dial-up is NOT recommended. EImhurst
College has a T1 line that is much faster. You may want to consider using that if your
personal computer is too slow.

Equally important is software. We suggest you use either Internet Explorer (IE) or Mozilla
Firefox as your browser. Netscape does not work well with BlackBoard. In the past,
students using AOL have had problems taking the course (for example they couldn't take
the exams!). Avoid dial-up access at all costs!!

If you need to upgrade (or change) your browser, you have 2 options: using your current
browser (including AOL), go to either Microsoft or Firefox, and find, download or install
the newest browser version. Unfortunately, unless you have a high-speed connection,
this will take a while (you could leave the process running overnight, for example).
Otherwise from the same sites, order the updates on a CD (usually costs $5-10).

This course requires Internet access; it is very important that your access be reliable.
Loss of access while accessing the course site will result in significant problems and may
adversely affect your grade. Therefore, it is strongly recommended that when you access
the site, you do it at a location with a reliable network connection. This may include:
Elmhurst College, a place of business with a dedicated Internet connection (your
employer?), or a public library.

If you find that you have technical troubles, it will be YOUR responsibility to access the
site from a more reliable location. There are NO makeup exams because of AOL
logging you off or if your computer crashed!!

Occasionally, we have had students enrolled in the class who have been unable to log in
from work. This is almost always due to security protocols with their workplace computer
systems. YOU will need to make other arrangements if this happens!

Finally - pop-up blockers will sometimes prevent exams and other pages from displaying
(many sites from the course open in a new window). You may have to disable your pop-
up blocker to fully enjoy the class! Sorry.

Security Issues

Every student has his or her own account for the online course. To prevent others from accessing
your account, it is very important that you follow these three guidelines:

Always exit IE or Firefox after each use. If you do not completely exit the program,
another user will be able to access your account without having to enter a User ID or
Password.

Upon logging in, if IE or Firefox asks whether or not to remember your Login and
Password, be sure to select NO. Selecting “yes” will allow another user to access your
account without having to enter your User ID or Password.



e Never reveal your User ID or password to anyone.

This is especially important if you use the computer with somebody else - a roommate, younger
sister, embittered spouse or significant other, etc. who might be inclined to hack away.

We take cheating seriously -- cheating is grounds for dismissal from the class, and possibly from
the College. This rule applies to online courses as well as regular courses. Unless it is instructed
for you to complete a group project, all work is to be done on an individual basis. Of course, you
may collaborate with others in the class via e-mail and the discussion board, but “copying” is not
allowed. Any two assighments with too similar wording will be flagged and examined
closely for copying. Collaboration and discussion — YES! Copying —NO!

Course Mechanics: How Does This Online Stuff Work?
Meteorology 101-52 Online is completely online! You will find supplementary textbook
information, links related to the material, exercises, discussion questions, and exams all on the
course web site. All of the course activities are self-contained in courseware called BlackBoard,
which runs through your browser.
Bottom line: if you are comfortable surfing the web, you should have very little difficulty navigating
the course. If you are more of a novice, don't worry - by taking this course online, you'll quickly
become experienced!

BlackBoard
When you first log into the course on BlackBoard, you'll be at the course homepage. Look
around...from here you can go to one of several locations, including the modules, where the
lecture material supporting the study unit is located. Look around and familiarize yourself with all
the options available!

Grading and Exam Timetable
Your overall course grade will be earned (BY YOU!) by completion of the following:

o Weekly lab exercises
e 4 exams
e Comprehensive Final exam

e Participation in online discussion (Important part of your grade in this
course)

e Grades will be posted after each week (usually Sunday night) so you can
see your status in the course

In order to pass this course, you are expected to participate in online discussions. The topics of
the discussion are assigned to each student (one question to answer per student each week or
partners may also be assigned, but individual grades are given) and will be posted every week.
They will generally focus on interesting weather, recent scientific articles, or other hot topics.
They are referred to as “Critical Thinking Questions” (CTQs) because the answer will not
necessarily be written in plain English in the text. They may require some investigation on your
part. Many do NOT have right answers, but leave room for discussion. You are not graded on
whether your response is technically right or wrong, but based on HOW you answer the question
and if you have some evidence to justify your response. Your participation will be graded based
on the quality of your work (including English style and level of scientific understanding). | have
developed rubrics (see syllabus for the rubric) for you to examine. This tells you HOW the
discussion posts will be graded. The level of your participation will also "count"...students who
respond to other student's postings and who make interesting contributions are SURE to get
higher grades than those who post, say, just one sentence. Do NOT just post "l agree" or “good
point!” That is NOT a viable post and you will NOT receive credit for those posts! Again, become
familiar with the grading rubric.



Put thought and effort into your responses. Quality is important here, not just quantity! Your
grade for participation is based upon the frequency and content of your postings. Post often, but
post well. Frequent posts with little or no substance will earn no credit. | strongly encourage each
of you to check the discussion board contents regularly to see what your classmates think - it's a
good way of keeping in touch with each other.

You must cite your sources correctly. A minimum of five (5) sources is required for full credit.
Three (3) resources is an immediate “C”. Use APA citation style. See rubric for further details.

Class Policies
All assignments, exercises, and exams must be completed by the given due date to receive
credit. You must notify me in advance if you are unable to take an exam on time--and if you have
a good reason. Otherwise, there will be NO make-ups on any assignment, exercise or exam.
During the exams, you may not discuss, post, or comment on any exam question with anyone
other than the instructor. This includes postings in the discussion area or via email. Students who
violate this policy are cheating and will be dealt with as harshly as permitted under College
Guidelines. This may include expulsion from the College. Again, you may, of course, discuss
concepts with your peers, but NOT copy or share exam answers. Keep in mind each exam is
different. You will NOT have the same exam questions as others in the course.

I’'m sure there will be questions as we move forward in the class, so please let me know via e-
mail (if it is a private issue) or on the discussion forum, so that everyone may profit from your
question.

The key to success in any online course is self-discipline, making sure you adhere to the agenda,
and communication.

| wish you the best of luck. Remember, I'm here to help.

See you online.

Dr. Schultz

richs@elmhurst.edu



